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   I. Apple Computer/Devices News  

	 A.  Apple needs to deliver an AI-charged Siri so 
good it gets older iPhone users to upgrade 
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KEY POINTS


• Apple spent much of the year battling President Donald 
Trump’s tariffs and the perception it has fallen behind rivals 
in AI.


• The company failed to deliver its update to Siri that 
would’ve added new generative AI features.


• Apple said it’s on track to launch the Siri upgrade in 2026, 
and it has just one more chance to get it right.
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Apple CEO Tim Cook speaks as Apple holds an event at the Steve Jobs 
Theater on its campus in Cupertino, California, Sept. 9, 2025.

Manuel Orbegozo | Reuters


Apple has one heck of a mulligan coming ahead of its 
50th anniversary in 2026.


After failing on its promise to launch an artificial 
intelligence-supercharged version of Siri in March, Apple 
said it’s on track to make it happen in the new year. The 
stakes are enormous.


Apple’s AI failure this year put even more pressure on it to 
deliver a breakthrough AI experience on the iPhone. 
Another whiff like that will only cement the idea that Apple 
is woefully behind its peers in AI and risks losing control 

https://www.cnbc.com/ai-effect/
https://www.cnbc.com/ai-effect/
https://www.cnbc.com/2025/04/11/heres-how-much-a-made-in-the-usa-iphone-would-cost.html


over the next major computing platform to a rival like 
Googleor a startup like OpenAI.


Not only that, Apple must prove to investors that AI can 
generate meaningful sales growth after years of post-
pandemic stagnation.    How Apple got here…


       B.  Ford Promises to Continue 
Offering Apple CarPlay, Despite 
Rivals Dropping It


Ford CFO Sherry House says the company will also 
incorporate Google Gemini in its cars next year.


By Jibin Joseph

December 30, 2025




(Credit: Apple)
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Ford has confirmed that it will continue to support Apple 
CarPlay in its cars.

Ford is "passionate" about retaining CarPlay since many 
customers use it, Ford CFO Sherry House said at the 
Barclays Global Auto and Mobility Tech Conference, Ford 
Authority reports.

"We think that that [CarPlay] is a product that our 
customers really enjoy, so we're going to continue to 
allow them to have access to that," House said…


	 C.  Report: Apple's AI Strategy Could 
Finally Pay Off  in 2026 
Tuesday December 30, 2025 9:01 am PST by Hartley Charlton 
Apple's restrained artificial intelligence strategy may pay off in 
2026 amid the arrival of a revamped Siri and concerns around the 
AI market "bubble" bursting, The Information argues. The 
speculative report notes that Apple has taken a restrained 
approach with AI innovations compared with peers such as 
OpenAI, Google, and Meta, which are investing hundreds of 
billions of dollars in data... 
Read Full Article • 199 comments 

	 D.  End of an era as last 
Intel MacBook Air is vintage 
NEWS

Remaining pool of viable Intel Macs shrinks even further.

By David Price 1 day ago 
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	 E.  Will Apple kick off  
2026 with a bang or a 
whimper? 
FEATURE 

January is likely to be a pretty slow month for Apple, but things 
will really pick up in the spring.

By Jason Cross 5 days ago


	  

 II.  APPLE HARDWARE  

	 A.  No iPhone 18 Launch This Year, Reports 
Suggest 
Thursday January 1, 2026 8:43 am PST by Hartley Charlton 
Apple is not expected to release a standard iPhone 18 model this 
year, according to a growing number of reports that suggest the 
company is planning a significant change to its long-standing 
annual iPhone launch cycle. Despite the immense success of the 
iPhone 17 in 2025, the iPhone 18 is not expected to arrive until 
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the spring of 2027, leaving the iPhone 17 in the lineup as the 
latest... 
Read Full Article • 

	 B.  Low-Price 12.9-Inch MacBook With A18 Pro 

Chip Reportedly Launching Early This Year 
Friday January 2, 2026 9:08 am PST by Joe Rossignol 
Apple plans to introduce a 12.9-inch MacBook in spring 2026, 
according to TrendForce. In a press release this week, the 
Taiwanese research firm said this MacBook will be aimed at the 
entry-level to mid-range market, with "competitive pricing." 
TrendForce did not share any further details about this MacBook, 
but the information that it shared lines up with several rumors 
about a more... 
Read Full Article • 137 comments 

	 C.  What's Happening With the Mac Pro? 

Wednesday December 31, 2025 9:59 am PST by Juli Clover 
Apple hasn't updated the Mac Pro since 2023, and according to 
recent rumors, there's no update coming in the near future. In 
fact, Apple might be finished with the Mac Pro. Bloomberg 
recently said that the Mac Pro is "on the back burner" and has 
been "largely written off" by Apple. Apple apparently views the 
more compact Mac Studio as the ideal high-end pro-level 
desktop, and it has almost... 
Read Full Article • 251 comments 

	 D.  Apple Says Final Intel MacBook 
Air and Apple Watch Series 5 Now 
'Vintage' 
Wednesday December 31, 2025 8:39 am PST by Eric Slivka 
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Apple today added the final 13-inch MacBook Air powered by Intel 
processors, the Apple Watch Series 5, and additional products to 
its vintage products list. The iPhone 11 Pro was also added to the 
list after the iPhone 11 Pro Max was added back in September. 
The full list of products added to Apple's vintage and obsolete list 
today: MacBook Air (Retina, 13-inch, 2020) iPhone 8 Plus 
128GB ... 
Read Full Article • 83 comments 

	 E.  Apple TV 4K Was Supposed 
to Launch in 2025… So What 
Happened? 

	 F.  Six new Apple products 
will launch early this year, 
here’s what’s coming 



Ryan Christoffel

 | Jan 5 2026 - 6:59 am PT


8 Comments
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Apple has a big year of 20+ product launches ahead, 
including six new products that are rumored to arrive in 
the next few months. Here’s what’s coming.


MacBook Pro 14-inch and 16-inch 
with M5 Pro and Max


https://9to5mac.com/2025/12/22/apple-will-launch-20-new-products-next-year-heres-whats-coming/




Last fall, Apple launched its new M5 chip in three 
products: MacBook Pro, iPad Pro, and Vision Pro.

But the new chip didn’t yet offer Pro or Max versions, and 
the only MacBook Pro that received it was the 14-inch 
model.

Reporting indicates Apple will launch 14-inch and 16-inch 
MacBook Pros with M5 Pro and M5 Max early in 2026.

Back in January 2023, Apple debuted M2 Pro and M2 
Max versions of the MacBook Pro. We could see similar 
timing with the M5 launches.


New 12.9-inch MacBook


https://9to5mac.com/2025/11/03/m5-macs-here-are-the-new-mac-models-reportedly-coming-next/
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For years, analysts have called on Apple to release a low-
cost MacBook that might better compete against 
Chromebooks and more affordable PCs. This year, it 
seems that may finally happen.

Apple is reportedly preparing a 12.9-inch MacBook that 
will run an iPhone-class A18 Pro chip and come in a 
variety of fun colors. Perhaps the best feature will be a 
rumored price of $599 or $699.

Analyst Jeff Pu is expecting the MacBook to ship in “mid-
Q1 2026.”


iPad with A18 chip


https://9to5mac.com/2025/08/12/new-12-9-inch-macbook-could-be-the-sleeper-hit-of-the-year/
https://9to5mac.com/2025/11/21/low-cost-macbook-and-more-launching-in-q1-2026-report-says/




Last year, Apple’s base model iPad got a spec bump 
update with an A16 Bionic chip.

But in the coming months, the next iPad is expected to 
launch with an A18 chip that will enable Apple Intelligence 
support.

Not much else is known about the new iPad. But it’s 
generally expected to retain the same design, with 
updates being primarily internal.


iPhone 17e


https://9to5mac.com/2025/11/21/low-cost-macbook-and-more-launching-in-q1-2026-report-says/




Apple has one more iPhone 17 model in the works, and 
it’s expected to launch very early in 2026.

Last February, Apple unveiled a new member of the 
iPhone family. The expected iPhone SE revision was 
actually branded iPhone 16e. Rumors later indicated 
Apple intends to update the ‘e’ model annually.

iPhone 17e will pack the same A19 chip as the iPhone 17, 
and the new Center Stage front camera too. It’s also 
rumored to have a pair of design changes: the Dynamic 
Island instead of a notch, and thinner bezels. MagSafe 
support is coming too.

Like iPhone 16e, Apple’s new budget model will likely 
cost $599 and still offer only one rear camera.


M5 MacBook Air
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Another new MacBook is coming early this year: the M5 
MacBook Air.

Very little is known about the update so far, other than it 
offering the same 13-inch and 15-inch sizes as the M4 
model. No design changes are expected either.

Like Apple’s other M5 products so far, the MacBook Air 
will likely be light on changes besides the M5 chip itself 
and perhaps some smaller additional improvements.


M4 iPad Air






If you want the best possible iPad, the M5 iPad Pro is an 
excellent option. But lots of users would be well off 
choosing the much more affordable iPad Air.

Rumors indicate Apple has an M4 iPad Air launching in 
the months ahead. There’s reportedly an OLED iPad Air in 
the works, but it likely won’t launch until next year.

Instead, expect the M4 model to offer more power and 
likely new colors, but not much else different.


Wildcard: New Apple Studio Display
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All of the above products are expected to launch in the 
months ahead. But there’s another that might debut soon 
too: a new Apple Studio Display.

The new Studio Display is rumored to add 120Hz 
ProMotion support with HDR, an A19 chip, and likely a 
new Center Stage camera. Since Apple doesn’t update its 
Mac displays very often, we could see some big changes.

Which early 2026 Apple products are you most interested 
in? Let us know in the comments.

Best iPhone accessories

• AirTag 4-pack (now only $65, down from $99)

• MagSafe Car Mount for iPhone

• AirPods Pro 3

• 10-year AirTag battery case 2-pack

• 100W USB-C fast charging power adapter 

https://9to5mac.com/2025/12/10/new-apple-studio-display-rumored-to-upgrade-three-key-features/
https://amzn.to/3DRkM1e
https://amzn.to/407e8Nx
https://amzn.to/4pmmv1U
https://amzn.to/4i7ILIJ
https://amzn.to/3wvpO0p


	 G.  New MacBook accessory 
adds touch support to your display 



Ryan Christoffel

6 hours ago


3 Comments 



The first touch-enabled Mac is rumored to launch later 
this year, but a new third-party ‘Magic Screen’ accessory 
says it can bring touch to existing MacBook Air and 
MacBook Pro displays.

EXPAND 
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	 H.  



• CES 2026


Best of CES 2026: All of the weird, wild, and 
wonderful reveals from the biggest show in 
tech 



from 9to5Toys

6 hours ago

CES 2026 – the biggest tech event of the year is now in full swing 
on the strip in Las Vegas with a countless number of new product 
reveals and wild new concepts. From desktop hologram 
machines and the new smart LEGO bricks, chargers that turn 
your phone into an AI robot assistant, the latest e-bikes, solar-
powered gazebos, smart goggles, and the latest in electric 
vehicle tech, CES knows no bounds. We have collected all of the 
wildest and most intriguing reveals from the show from across 
our network for your browsing pleasure below. 

READ MORE 
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	 I.  This is how long Macs 
and MacBooks last

FEATURE


Find out how long MacBooks last, how long Apple supports 
Macs and MacBooks for, and how to tell if a Mac is too old.


	  

III. Apple Software 

	 A.  50 macOS Tahoe Features 
New features and lesser-known changes to check out if you're 
upgrading. 

	 B.  Apple Teases 'Something Big' 
Coming Soon to Apple Fitness+ 
Tuesday December 30, 2025 2:11 pm PST by Juli Clover 
The Apple Fitness+ Instagram account today teased that the 
service has "big plans" for 2026. In a video, several Apple 
Fitness+ trainers are shown holding up newspapers with 
headlines related to Apple Fitness+. What's Apple Fitness+ 
Planning for the New Year? Something Big is Coming to Apple 
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Fitness+ The Countdown Begins. Apple Fitness+ 2026 is Almost 
Here 2026 Plans Still Under ... 
Read Full Article • 121 comments 

	 C.  10 Mac Apps That Will 
Change How You Use macOS in 
2026 

	 D.  Everything Apple Is 
Releasing in 2026: iPhone Fold, LLM 
Siri, Low-Cost MacBook and More 
Wednesday December 31, 2025 10:39 am PST by Juli Clover 
If rumors are accurate, 2026 is going to be a huge year for Apple. 
We're expecting the first foldable iPhone, an all-new home hub 
device, updated displays, and possibly, the first OLED MacBook 
Pro and the first AI smart glasses. Subscribe to the MacRumors 
YouTube channel for more videos. Apple will split its ‌iPhone‌ 
launches, introduce a low-cost MacBook, and debut a much 
smarter, LLM-based... 
Read Full Article • 100 comments 

	 E.  macOS Tahoe icons do 
exactly what Apple said 
designers should never do 
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Ben Lovejoy

11 hours ago


40 Comments 



macOS Tahoe app icons came under fire late last year 
with commenters describing them as “terrible” and 
“objectively bad.” In our poll, 9to5Mac readers had 
exceedingly mixed views.

Software engineer Nikita Prokopov has now drawn 
attention to the icons used within menus and pointed out 
that they almost exactly mirror the approach which 
Apple’s Macintosh Human Interface Guidelines advised 
against back in 1992 …

Prokopov shared a graphic from the guidelines which 
showed what Apple described as an “ugly” menu, with 
each item having its own icon, contrasted with what the 
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company considered good practice, which was very few 
in-menu icons.




He then points to Apple breaking this guideline with Tahoe 
menus.




Admittedly, resolutions have improved dramatically since 
those days, and it could be argued that in-menu icons 



today are much clearer, but Prokopov argues against that 
too.

The main function of an icon is to help you find what you 
are looking for faster. Perhaps counter-intuitively, adding 
an icon to everything is exactly the wrong thing to do. To 
stand out, things need to be different. But if everything 
has an icon, nothing stands out.

He suggests the approach Microsoft took in the early 
days, with icons restricted to only the most commonly 
used functions, is a better one.

But it gets worse. He also points out that Apple uses 
inconsistent icons for the exact same function in different 
apps – Including things as basic as New. Depending on 
the app, Apple uses five markedly different icons to 
essentially mean the same thing.

As if that weren’t bad enough, he also points to examples 
where Apple uses the exact same icon to mean 
completely different things! For example, the icon for a 
new note in the Notes app is the same one as the “edit 
address” icon in the Contacts app.

His blog post is illustrated with a great many examples, as 
well as suggested improvements using fewer icons and 
colour coding them. It’s definitely worth checking out.

Once you’ve taken a look at his examples, do share your 
thoughts in the comments.

• Official Apple Store on Amazon

• NordVPN – privacy-first VPN with no logs and 

independent audits to verify

• Official Apple iPhone Air cases and bumpers


https://tonsky.me/blog/tahoe-icons/
https://amzn.to/3UaJjDn
https://nordvpn.com/9to5mac
https://nordvpn.com/9to5mac
https://amzn.to/4nhuTP7


• iPhone Air MagSafe Battery

• Official iPhone cases: iPhone 17 | iPhone 17 

Pro and Pro Max | iPhone Air

Image: Nikita Prokopov. Via Daring Fireball.


	  

IV. IOS KORNER  
	 A.  iOS 26.2 Brings Upgrades for 
Liquid Glass, AirDrop, and Apple Music 
The latest iOS update means more ways to enable Liquid 
Glass, new security features for AirDrop file sharing, and 
new ways to keep on top of your Reminders.


By Will McCurdy

December 14, 2025


https://amzn.to/4mf8f8H
https://amzn.to/3V8m7X8
https://amzn.to/48h0mMH
https://amzn.to/3V8m7X8
https://amzn.to/46hmLGM
https://amzn.to/46hmLGM
https://amzn.to/4n1DuVQ
https://amzn.to/48h0mMH
https://tonsky.me/blog/tahoe-icons/
https://daringfireball.net/linked/2026/01/05/hard-to-justify-tahoe-icons
https://www.pcmag.com/news/ios-262-brings-upgrades-for-liquid-glass-airdrop-and-apple-music
https://www.pcmag.com/news/ios-262-brings-upgrades-for-liquid-glass-airdrop-and-apple-music
https://www.pcmag.com/authors/will-mccurdy
https://threads.net/intent/post?text=https%3A%2F%2Fwww.pcmag.com%2Fnews%2Fios-262-brings-upgrades-for-liquid-glass-airdrop-and-apple-music
https://bsky.app/intent/compose?text=https%3A%2F%2Fwww.pcmag.com%2Fnews%2Fios-262-brings-upgrades-for-liquid-glass-airdrop-and-apple-music
http://www.reddit.com/submit?url=https%3A%2F%2Fwww.pcmag.com%2Fnews%2Fios-262-brings-upgrades-for-liquid-glass-airdrop-and-apple-music&title=iOS%2026.2%20Brings%20Upgrades%20for%20Liquid%20Glass%2C%20AirDrop%2C%20and%20Apple%20Music




(Credit: Nasir Kachroo/NurPhoto via Getty Images)


Apple has now rolled out iOS 26.2, bringing a few helpful—if 
small—new features for iPhone 11 or 2nd-generation iPhone 
SE and later users, MacRumors reports.

If you enjoyed the Liquid Glass feature Apple added in iOS 
26.1, it’s now also being added to the Lock Screen. You can 
now use a slider inside your Lock Screen options to make the 
clock more or less transparent, while you can also still opt for 
a completely solid clock. In contrast, iOS 26.1 only made it 
possible to make your Liquid Glass material either Clear or 
Tinted. Liquid Glass is also being incorporated into other 
parts of the OS, including the Measure app, Apple's free 
ruler-like measuring tool.


If you're the forgetful type, the Reminders tab now has an 
option to add an alarm for when the reminder is due. You’ll 
need to toggle the Urgent option when setting up the 
reminder to create the alarm. If you choose to snooze the 
reminder, it will show a Live Activity countdown on the Lock 
Screen that includes an option to complete the reminder or 
reschedule it.


https://www.macrumors.com/guide/ios-26-2-features/


The update adds a new layer of verification when you're 
using AirDrop with unknown contacts, allowing you to share 
files more securely. Apple has introduced an option to 
generate an AirDrop code on the device you want to share a 
file with. This code can then be entered on your device to 
complete the transfer. These codes allow AirDrop to work 
between the two devices for 30 days before automatically 
deactivating.

Apple Music is also getting a few helpful updates if it’s 
something you regularly use offline. You can now see the 
lyrics to the song you're playing when not connected to Wi-Fi 
or cellular data…


	 B. iOS 26.1 Update Offers Liquid Glass 
Controls, Bevy of  Handy New Features 
The first major iOS 26 update brings live translation 
improvements, streamlined gesture controls, new visual 
settings, and more. Updates are also available for iPadOS 
and macOS.

By Jon Martindale

November 4, 2025
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(Credit: Apple) Apple has launched iOS 26.1, its first updates 
since the iOS 26 launch in September.

Compatible with iPhone 11 series and later and the second-
generation iPhone SE devices, this update brings with it a 
number of quality-of-life changes, including new language 
support in Apple Intelligence, better live translation support, 
and improved gesture controls in a range of apps and 
services, among others. 

Apple's iOS 26 debuted with an overhauled Liquid Glass 
visual design to give the latest iPhone OS a wonderfully 
uniform look. Call screening and hold assist were really useful 
additions, and the Spatial Scenes can make a real difference 
to wallpapers and photos. If we had any complaints, it's that 
there were some obvious bugs and the interface needed just 
a few tweaks here and there. Update 26.1 may fix most of 
our concerns.

The new update brings improvements to Apple Intelligence 
language support, adding Danish, Dutch, Norweigian, and 
Turkish, among others. It's also added Chinese (both 
simplified, and traditional) to Live Translation on AirPods, as 
well as Italian, Japanese, and Korean. Elsewhere, Apple has 
left-aligned text and icons for more comfortable interface 
viewing and navigation, and there's a new video scrubber in 
photos to slide through the few frames of animation.


Liquid Glass has been updated with a new option to choose 
between the default clear look, or a tinted look that can 
increase opacity in certain apps and notifications on the lock 
screen, making them easier to read. There are also new 
toggles in the Settings menu for haptic feedback, single-

https://support.apple.com/en-us/123075
https://www.pcmag.com/reviews/apple-ios-26
https://www.pcmag.com/news/live-translation-doesnt-require-airpods-pro-3-but-you-do-need-this
https://www.pcmag.com/news/your-iphone-or-mac-may-soon-let-you-pick-how-transparent-liquid-glass-is


touch actions, and lock-screen swipe to open to camera. In a 
tweak of its gesture support, Apple added "Slide to Stop" 
swipe actions to Alarms and Timers (so everyone stops 
turning off their alarm when they're trying to snooze) and the 
Music MiniPlayer now supports swipes to go to next and 
previous track. 

The Fitness app has been updated to add support for custom 
workouts, letting you set your own exercise regime, and 
Apple has improved FaceTime audio quality in low-
bandwidth conditions, so if you don't have great signal, you 
should at least be able to hear who you're speaking to, even 
if the video quality isn't excellent. 

To better protect younger iPhone users, too, Apple has 
instigated a new Communication Safety and Web content 
filter system that will automatically limit adult website access 
on child accounts for ages 13-17 (although the specific ages 
do vary by region).

The new update also introduced Apple's Security 
Improvements feature via a revamped Rapid Security 
Responses toggle. You can turn this off and on in the 
Settings menu, but it effectively means security updates are 
installed automatically, speeding up your device's protective 
measures so you are never caught out.

You can update your device by going to Settings > General > 
Software Update. The update is available for all iPads and 
iPhones that are compatible with the iOS 26 update.

Apple today also released the 26.1 versions of iPadOS, 
macOS Tahoe, tvOS, watchOS, and visionOS. As 
MacRumors notes, iPadOS 26.1 revives Slide Over, a 
multitasking feature that Apple axed in ‌iPadOS 26‌... 

https://www.macrumors.com/2025/11/03/apple-releases-ipados-26-1/
https://support.apple.com/en-us/123074
https://www.pcmag.com/news/your-next-big-ipad-update-removes-split-screen-and-slide-over-multitasking


	 C.  Apple iOS 26.3 Release Date: The First 

Major iPhone Update Of  2026 Is Almost Here 
ByDavid Phelan,Senior Contributor. I write about lifestyle tech


Jan 01, 2026 at 05:00pm EST


Apple’s next iPhone software update, unless there’s a small 
release to squish some bugs in the interim, will be iOS 
26.3. That software began its journey through developer 
beta on Dec. 15. A new report sheds light on exactly when 
the general release will be. 

 
Apple iPhone 17 
ANADOLU VIA GETTY IMAGES


“Apple tends to ship its “x.3” iOS updates in late January. 
The dates move around by a day or two, but the window 

https://www.forbes.com/sites/davidphelan/2026/01/01/apple-ios-263-release-date-the-first-major-iphone-update-of-2026-is-almost-here/
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stays nearly the same year after year. If Apple sticks to its 
recent pattern, iOS 26.3 should arrive in the last week of 
January 2026,” MacObserver reported. 
FORBES 

Warning: Apple’s Latest iPhone Update Has 
Unexpected Consequences For Nearly A Billion Users 
By David Phelan 

There had been speculation that because iOS 26.1 landed 
later than is Apple’s custom, in early November rather 
than late October. But the Cupertino giant seemed to have 
caught up with itself after that, and the most recent big 
update, iOS 26.2, went on release on Dec. 12, even if that 
release took some commentators by surprise by landing on 
a Friday instead of the customary Monday or Tuesday. 

One thing seems certain about iOS 26.3: there won’t be an 
accompanying iOS 18 release for those wanting to keep 
their iPhones safe from bugs and security risks. There was 
an iOS 18.7.2 release alongside iOS 26.1, and it looked like 
iOS 18.7.3 was on its way, but in the end that was only 
released for iPhones which aren’t capable of handling iOS 
26…. 

	 D. 15 New Things Your 
iPhone Can Do in iOS 26.2    

Tuesday December 23, 2025 3:25 am PST by Tim Hardwick 
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Apple this month rolled out iOS 26.2, the 
second major point update for iPhones 
since iOS 26 was released in September, 
and there are at least 15 notable changes 
and improvements worth checking out. 
We've rounded them up below. 

 
 
Apple is expected to roll out iOS 26.3 to compatible devices 
sometime in late January 2026. Until then, here's what's new in 
iOS 26.2. 

1. Set a Reminder Alarm 



 
 
iOS 26.2 brings a new alarm capability to the Reminders app. 
When you create a reminder, you can toggle on an "Urgent" 
option so that, at the due time, your iPhone sounds an alarm 
rather than simply showing a notification. 

2. Adjust Liquid Glass Clock 

 
 
Apple's latest update adds a new slider under the "Liquid Glass" 
Lock Screen settings that gives much finer control over the 
clock's appearance. You can choose to make the time display 
nearly fully transparent, or more frosted and opaque, rather than 
being limited to the previous fixed presets. 

3. AirDrop Files to People Not in 
Contacts 



 
 
iOS 26.2 introduces a one-time AirDrop code system, letting you 
share files with someone even if they're not in your contacts. 
Once generated, the code remains valid for 30 days. Apple also 
includes a "Manage Known AirDrop Contacts" pane so that you 
can see and manage the people you've shared codes with. 

4. View Apple Music Lyrics 
Offline 

 
 
Apple Music is gaining offline lyrics support, so you can now view 
song lyrics in the app even when your iPhone isn't connected to 
Wi-Fi or mobile data. 

5. Get a Better Sleep Score 



 
 
If you wear your Apple Watch in bed, it's worth knowing that 
Apple has reworked its Sleep Score scoring tiers, with the aim of 
better matching typical sleep-quality experiences. Now, "Very 
Low" runs 0–40 (previously 0–29), "Low" 41–60, "OK" 61–80, 
"High" 81–95, and "Very High" 96–100 (previously labelled 
"Excellent"). 

6. Automatically Create Podcast 
Chapters 

 
 
The Podcasts app can now automatically generate chapters for 
individual episodes. This means that rather than fixed chapter 
markers, the app will create them for you – and episode 
transcriptions now let you tap on mentions of other podcasts or 
links. 



7. Manage Websites Where 
Passwords Aren't Saved 

 
 
In the Passwords app's main settings menu, there's a new section 
allowing you to review and manage websites where you have 
deliberately avoided saving credentials. It gives you finer control 
over which domains are excluded from password storage. 

8. Get AirPods Live Translation 
in EU 
 
 
Apple's latest update expands the reach of AirPods Live 
Translation to countries in the European Union. The feature was 
previously unavailable in the EU due to Apple's ongoing 
regulatory compliance work. 

9. Flash iPhone Screen for Alerts 
 
 
In the Accessibility settings, under "Flash for Alerts," you can now 
choose to have your iPhone screen flash when a notification 



arrives, rather than just the rear camera's LED flash. You can 
configure it to use the screen flash alone, the LED flash, or both 
simultaneously, giving you more flexibility for alert styles. 

10. Quicker Access to Apple 
News Sections 
 
 
The Apple News app gets a refreshed interface. The top-of-feed 
buttons now let you jump quickly into categories (e.g. sports, 
business, food, puzzles) instead of scrolling or tapping through 
menus. 

11. Manage Safety Alerts 
 
 
iOS 26.2 introduces an "Enhanced Safety Alerts" section in 
Notifications settings that centralizes earthquake alerts, 
imminent-threat alerts, and also includes a new location-based 
"improved alert delivery" option, helping ensure the reliability of 
alerts. 

12. Sort Games by Size 
 
 
In the Games app library, there's now an option to sort games by 
size (in addition to name or recent). It should prove useful if you 
want to clear storage or identify large games quickly. Beyond 
sorting, the update also brings support for controller-based 
navigation and real-time challenge-score updates while playing. 



13. Disable Pinned Messages in 
CarPlay 
 
 
For CarPlay users, iOS 26.2 lets you disable the new "pinned 
messages" view in the Messages app – restoring the older, classic 
messages interface if you prefer that simpler look while driving. 

14. Replace Siri Side Button 
Functionality (in Japan) 
 
 
For iPhone users registered in Japan, iOS 26.2 lays the foundation 
for replacing the default voice assistant triggered by the Side 
button from Siri to a third-party voice assistant (for example, 
Gemini or Alexa), giving users a choice at the system level for the 
first time. 

15. Multitask More on iPad 
 
 
For iPad users, iPadOS 26.2 restores some multitasking flexibility, 
and allows you to drag and drop apps from the App Library, Dock, 
or Spotlight into Split View or Slide Over. The change should 
make window and multitask management on iPad more fluid. 



	 E. iPhone 17 vs iPhone 17 Pro 
vs iPhone Air 
Apple's four new iPhones feature more differences between the latest 
models than ever before, so which one should you buy? 

	 F.  Apple Intelligence Guide 

Apple Intelligence is what Apple calls its artificial intelligence 
feature set, previewed at WWDC in June 2024. The first 
Apple Intelligence features launched with iOS 18.1, iPadOS 
18.1, and macOS Sequoia 15.1, and additional features came 
in iOS 18.2, iPadOS 18.2, and macOS Sequoia 15.2. There's 
still more to come, though, and the rest of the Apple 
Intelligence features are set to come later in 2025…. 
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Macs can run out of storage space, which can slow down 
their performance or even prevent you from saving new 
files. However, there are several quick and effective 
methods to help you reclaim valuable storage. These 
range from simple actions, such as emptying the Trash, to 
more advanced techniques like using Optimized Storage 
or removing duplicate files.


This article outlines these methods, compares their 
effectiveness, and addresses common questions about 
managing storage on your Mac. By following these tips, 
you can keep your Mac running smoothly and efficiently.







Effective Mac Storage 
Management 

Quick Ways To Free Up Space

If your Mac is running low on storage, there are simple 
steps you can take. These steps will help you quickly 
reclaim space. We will explore some of these methods.


EMPTY THE TRASH 



The Trash holds deleted files. These files still take up 
space. Emptying the Trash is a fast way to free up space. 
Right-click the Trash icon and select “Empty Trash”.


DELETE LARGE FILES 
Large files like movies and videos use a lot of storage. 
Find and delete files you no longer need. You can use 
Finder to sort files by size. This makes it easy to find large 
files.


UNINSTALL UNUSED APPS 
Apps you don’t use take up space. Uninstall apps you no 
longer need. Dragging the app to the Trash does not 
always remove all files. Use the app’s uninstaller if it has 
one.


USE OPTIMIZED STORAGE 
macOS has a feature called Optimized Storage. It can 
store files in iCloud. This frees up space on your Mac. You 
can access these files when you need them. 


Go to System Settings > Apple ID > iCloud > Optimize 
Mac Storage.


More Advanced Methods 
If the quick methods are not enough, try these:




REMOVE DUPLICATE FILES 
Duplicate files waste space. Use a duplicate file finder 
app to find and remove them. There are many apps 
available for this.


CLEAN UP SYSTEM FILES 
System files can take up space. Use a cleaning app to 
remove temporary files and caches. Be careful when 
deleting system files. Removing the wrong files can cause 
problems.






Comparison Of Methods


Questions You Might Have 
HOW DO I FIND LARGE FILES?

Open Finder. Press Command + F. Click “Kind” and select 
“Other”. Choose “File Size”. Set the size limit.


ARE CLEANING APPS SAFE TO USE?

Some cleaning apps are safe. Others are not. Research 
apps before you use them.




Managing Storage On Other 
Devices 
The need to manage storage is not unique to Macs. 
iPhones and iPads also have limited storage. Many of the 
same principles apply. You can delete unused apps, 
remove large files like videos, and use cloud storage to 
free up space. On mobile devices, it is also useful to 
check app storage settings. Some apps store a lot of 
data. You can often clear this data within the app’s 
settings to reclaim storage space. Regularly managing 
storage across all your devices ensures they run 
smoothly.


Managing Mac Storage Space 

VIDEO

How to free up space on your Mac on macOS Catalina or 
earlier — Apple Support


Macs offer several built-in tools to help users optimize 
storage space. The Storage Management feature 
provides a clear overview of disk usage, categorizing files 
and suggesting ways to free up space. iCloud integration 

https://www.youtube.com/watch?v=ha2DhifzZZI
https://www.youtube.com/watch?v=ha2DhifzZZI
https://www.simplymac.com/macos/how-to-save-files-on-a-mac
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https://www.simplymac.com/icloud/how-to-delete-stuff-from-icloud


allows users to store files, photos, and videos in the 
cloud, freeing up local storage.


Users can delete large, unnecessary files and clear out 
old backups to reclaim space quickly. The Photos app 
offers options to optimize storage by keeping full-
resolution images in iCloud while storing smaller versions 
locally. Emptying the Trash and clearing browser caches 
can also help.


For more advanced cleanup, third-party apps like 
CleanMyMac X and Gemini 2 can identify and remove 
duplicate files, temporary data, and other space-hogging 
items. These tools often provide a more comprehensive 
approach to storage management.


Frequently Asked Questions 

Finding And Removing Large 
Files On Mac 
Mac users can locate and delete large, unnecessary files 
by using Finder’s search function. Click on the Finder 
icon, then select “File” and “Find.” Use the size filter to 
show files larger than a specific size. Sort results by file 



size to identify the biggest space-hogs. Right-click 
unwanted files and select “Move to Trash” to delete them.


Clearing ‘Other’ Storage On Mac 
To reduce ‘Other’ storage on a Mac:


1. Empty the Trash

2. Clear browser caches

3. Remove language files you don’t use

4. Delete old backups and downloads


Use third-party cleaning apps for a more thorough 
cleanup of system junk and temporary files.


Storage Management For 
MacBook Air 
MacBook Air users can optimize storage by:


• Using iCloud for photos and documents

• Uninstalling unused apps

• Removing old iOS backups

• Emptying the Trash regularly


Enable “Optimize Mac Storage” in iCloud settings to 
automatically remove local copies of files stored in the 
cloud when space is low.


https://www.simplymac.com/macos/backing-your-mac-or-macbook-procedure


Resolving Full Storage On 
MacBook Pro 
If a MacBook Pro shows full storage:


1. Check storage breakdown in “About This Mac”

2. Delete large, unnecessary files

3. Move data to external drives

4. Use cloud storage services


Consider upgrading the internal SSD if storage issues 
persist after cleanup efforts.


Automatic Deletion Of 
Temporary Files On Mac 
Macs don’t have a built-in feature to automatically delete 
all temporary files. Users can:


• Use third-party cleaning apps with scheduled 
cleanups


• Create custom scripts to clear specific cache folders

• Set up Automator workflows for regular maintenance


Manual deletion through Terminal commands is also an 
option for tech-savvy users.




Monitoring And Maintaining Mac 
Disk Space 
To keep track of Mac disk space:


1. Use the built-in Storage Management tool

2. Install disk space analyzer apps

3. Set up low disk space alerts


Perform regular cleanups and consider upgrading storage 
or using external drives for long-term file storage.
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Tired of struggling with passwords? Apple’s passkeys 
offer a simpler and safer way to sign in to your favorite 
apps and websites. Passkeys are replacements for 
passwords that work across your Apple devices, making 
login faster and more secure. You can create and save 
passkeys on your iPhone to replace traditional passwords 
for supported websites and apps, eliminating the 
frustration of forgotten credentials and security risks.


Apple has designed passkeys to provide what many users 
have wanted for years – security without the hassle. 
Unlike traditional passwords, passkeys can’t be phished 
and don’t need to be remembered. They use advanced 
encryption to protect your accounts while making the 
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sign-in process much easier. Your fingerprint or face scan 
is all you need to access your accounts.


The system works seamlessly across the Apple 
ecosystem, with your passkeys stored securely in iCloud 
Keychain. This means you can start using a service on 
your iPhone and continue on your Mac without any extra 
steps. Managing your passkeys is simple through your 
device settings, giving you full control over your digital 
identity.


Apple Passkey Guide (2026) 
Apple Passkeys are Apple’s password‑less sign‑in system 
designed to make logging in faster, safer, and easier. By 
2026, passkeys are widely supported across apps, 
websites, and devices, replacing traditional passwords for 
many services.


This guide explains what Apple Passkeys are, how they 
work, how to use them, and what to do if something goes 
wrong…(Read more by clicking on link in title)


	 I.  Restart Mac in Safe 
Mode: A Step-by-Step Guide

Ali Mohammadi
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Restarting a Mac in safe mode is a trusted method to 
diagnose issues related to the startup process. Safe 
mode, also known as safe boot, loads the operating 
system without any unnecessary programs or extensions 
which could be causing problems. This can be particularly 
useful when a Mac is not starting up as it normally does, 
or when the system is behaving unpredictably.


Safe mode also performs a check of the startup disk, so it 
can not only help with troubleshooting but also with disk 
repair. Starting a Mac in safe mode varies slightly 
depending on if the computer uses Apple silicon or an 
Intel processor. In any case, the process is 

https://www.simplymac.com/category/mac
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straightforward and can lead to resolving issues that 
prevent the Mac from operating smoothly.


Restart Mac in Safe Mode: A 
Step-by-Step Guide 
Starting your Mac in Safe Mode is a powerful 
troubleshooting step when your computer is running 
slowly, freezing, or behaving unexpectedly. Safe Mode 
limits what macOS loads at startup, helping you identify 
and fix software-related issues.


This guide walks you through what Safe Mode is, when to 
use it, and how to restart any Mac in Safe Mode, 
including both Apple silicon and Intel-based models.


What Is Safe Mode on Mac? 
Safe Mode (also called Safe Boot) starts macOS with only 
essential system components. When your Mac starts in 
Safe Mode, it:


• Checks your startup disk for errors

• Loads only required system extensions

• Disables third-party startup items and login items




• Clears certain system caches

If a problem doesn’t occur in Safe Mode, it’s likely caused 
by a third‑party app, extension, or login item.


When Should You Use Safe 
Mode? 
Use Safe Mode if your Mac is experiencing:


• Slow startup or shutdown

• Frequent crashes or freezes

• Apps that won’t open

• Display issues

• Kernel panics

• Problems after installing new software


How to Restart a Mac in Safe 
Mode 
The steps depend on whether your Mac uses Apple 
silicon (M1, M2, M3, etc.) or an Intel processor.




 Safe Mode on Apple Silicon 
Macs (M1, M2, M3, and newer)


1. Shut down your Mac completely

• Click Apple menu  > Shut Down, and wait until 

the screen turns off.

2. Press and hold the Power button


• Keep holding it until you see “Loading startup 
options.”


3. Select your startup disk

• Usually labeled Macintosh HD.


4. Hold the Shift key, then click Continue in Safe Mode

5. Log in to your Mac


• You may need to log in twice. This is normal in 
Safe Mode.


 You’ll see “Safe Mode” in the menu bar once macOS 
finishes loading.


 Safe Mode on Intel-Based 
Macs


1. Restart or power on your Mac

2. Immediately press and hold the Shift key

3. Release the Shift key when you see the login window




4. Log in to your Mac


 The words “Safe Boot” will appear in the menu bar if 
Safe Mode is active.


How to Exit Safe Mode 
Exiting Safe Mode is simple:


1. Click the Apple menu 

2. Select Restart

3. Let your Mac start normally (do not hold any keys)


Your Mac will return to its standard startup mode.


What to Do After Starting in Safe 
Mode

Once in Safe Mode, try the following:


• Open apps to see if the issue still occurs

• Remove recently installed apps or extensions

• Check System Settings > General > Login Items and 

disable unnecessary items

• Run Disk Utility > First Aid




• Update macOS and installed apps

If the issue does not occur in Safe Mode but returns after 
restarting normally, a third‑party app is likely the cause.


Safe Mode Limitations 
While in Safe Mode, some features may not work, 
including:


• Wi‑Fi or Bluetooth (may be limited)

• Graphics acceleration

• Video playback

• Certain USB or Thunderbolt devices


This is expected behavior.


Final Thoughts 
Restarting your Mac in Safe Mode is one of the easiest 
and most effective ways to troubleshoot macOS issues. 
Whether you’re using an Apple silicon or Intel-based Mac, 
Safe Mode can help you identify problems and restore 
stability.


Key Takeaways 



• Safe mode helps diagnose startup issues on a Mac.

• It performs a disk check and prevents non-essential 

programs from loading.

• The process for entering safe mode differs between 

Apple silicon and Intel Macs.


Preparing to Start Mac in Safe 
Mode 

VIDEO

How To Get Your Mac Into Safe Mode | Mac Tutorial | 
Quick & Easy Guide


Before attempting to start your Mac in Safe Mode, it’s 
important to understand the requirements and functions. 
This ensures a smooth process and helps you 
troubleshoot issues more effectively.


Checking System Requirements 
Starting your Mac in Safe Mode begins by confirming 
your Mac type. This is crucial as the steps differ between 
Apple Silicon Macs and Intel-based Macs.


https://www.youtube.com/watch?v=p8APQ9uVyRQ
https://www.youtube.com/watch?v=p8APQ9uVyRQ


• Apple Silicon Macs: First, make certain your Mac is 
completely powered off. Only then should you 
proceed.


• Intel Macs: You can start from either an off state or 
during a reboot.


You can check your Mac type by selecting the Apple 
menu and clicking About This Mac. The details there 
provide the information you need.


Understanding Safe Mode 
Functions 
Safe Mode on a Mac performs checks during startup. It 
verifies your startup disk and loads only essential kernel 
extensions. It also disables third-party fonts and clears 
certain caches, such as system cache and kernel cache. 
This is like giving your Mac a fresh start.


Here’s what Safe Mode does: 

• Scans the disk: It checks for file system issues that 
could be causing problems.


• Blocks startup and login items: Apps that usually 
open automatically won’t do this in Safe Mode.


• Disables third-party fonts: Only fonts that come with 
your Mac remain active.




• Deletes font caches, kernel cache, and system 
cache: This helps remove corrupted data which may 
resolve performance issues.


By understanding these functions, you prepare to 
troubleshoot software and hardware issues effectively. 
Safe Mode helps identify problems by limiting what runs 
on your Mac. This makes it a valuable first step in the 
troubleshooting process.


Steps to Restart Mac in Safe 
Mode 
When your Mac starts acting up, restarting it in Safe 
Mode can be a helpful troubleshooting step. This special 
boot mode performs certain checks and prevents some 
software from automatically loading or opening.


Restart Process For Intel-Based 
Macs 
For MacBooks with Intel processors, the restart in Safe 
Mode is straightforward. First, shut down the Mac. Then, 
power it on and immediately press and hold the Shift key. 
When you see the Apple logo, you know the process has 
started. Let go of the Shift key when the login window 



appears. You should enter your password and move 
forward. With this done, your Mac should now be in Safe 
Mode.


Restart Process For Apple 
Silicon Macs 
Apple Silicon Macs like the M1 MacBooks need 
different steps. First, shut down your device. Hold down 
the power button until the Startup Options appear. Click 
the gear icon labeled Options. Next, select a volume. 
Press and hold the Shift key and click “Continue in Safe 
Mode”. Then release the Shift key. After logging in, your 
Mac should be operating in Safe Mode.


	 J.  How to Print a 
Screenshot on Mac

Owen Woods

January 5, 2026
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Capturing a screenshot on a Mac is a simple process that 
can be useful for a variety of tasks, from creating tutorials 
to saving a memorable conversation. macOS provides 
built-in shortcuts to take screenshots in different ways. 
You can capture the entire screen, a specific window, or a 
selected portion. Once taken, the screenshot can be 
found as a .png file on the desktop or in a specified folder, 
ready for viewing, editing, or printing.


Printing the captured screenshot involves opening the 
image file, typically with the Preview app that comes 
installed on all Macs. The file can also be opened with 
other image-editing applications if needed. After opening 

https://www.simplymac.com/iphone/how-to-iphone-screenshot


the image, the print option within the application allows 
you to print the screenshot with your connected printer.


How to Print a Screenshot on 
Mac 
You can’t print a screenshot directly with a keyboard 
shortcut on macOS, but you can easily capture the 
screenshot and then print it.


Step 1: Take a Screenshot

Use one of these keyboard shortcuts:


Capture The Entire Screen

• Command (⌘) + Shift + 3

• Saves the screenshot to your desktop (by default).


Capture A Selected Area

• Command (⌘) + Shift + 4

• Drag to select the area you want to capture.


Capture A Complete Window




• Command (⌘) + Shift + 4, then press Spacebar

• Click the window you want to capture.

•

Screenshot Toolbar (All Options)

• Command (⌘) + Shift + 5

• Choose capture options, timers, and save locations.


Step 2: Open the Screenshot

• Click the screenshot thumbnail that appears in the 

bottom‑right corner, or

• Double‑click the screenshot file on your Desktop or 

in Finder.

The screenshot will open in Preview by default.


Step 3: Print the Screenshot

1. With the screenshot open in Preview, click File in the 

menu bar.

2. Select Print (or press Command ⌘ + P).

3. Choose your printer.

4. Adjust settings such as:


• Paper size

• Orientation

• Scale




• Color or black & white

5. Click Print.


Optional: Resize or Crop Before 
Printing


Crop The Screenshot

• In Preview, click the Selection Tool.

• Drag to select the area you want.

• Click Tools → Crop.

•

Resize The Image

• Go to Tools → Adjust Size.

• Change dimensions or resolution for better print 

quality.


Printing Without Saving the 
Screenshot

If you want faster printing:


1. Take a screenshot.

2. Click the thumbnail immediately.




3. Click File → Print before closing it.


Troubleshooting Tips 
Screenshot is too large or small


• Adjust the Scale option in the Print dialog.


Print looks blurry


• Use a larger capture area.

• Avoid excessive resizing.

• Check printer quality settings.

•

Can’t find the screenshot


• Default location is Desktop.

• Check Command ⌘ + Shift + 5 → Options to see or 

change the save location.


Summary

1. Take a screenshot (⌘ + Shift + 3 / 4 / 5)

2. Open it in Preview

3. Press ⌘ + P to print


Key Takeaways




• Macs offer various shortcuts to take screenshots.

• Screenshots are automatically saved as image files.

• Use Preview or another image viewer to print 

screenshots.


Taking Screenshots on a Mac

Mac users have various options for taking screenshots, 
whether capturing the entire screen, a portion of it, or a 
specific window. Simple keyboard shortcuts enable these 
functions, which store images on the desktop by default.


VIDEO


How to Print Screen or Take Screenshot on Mac? | 
Shortcut & Method 

Capturing The Entire Screen

To take a snapshot of everything on your Mac’s display, 
press Shift-Command-3. This command captures the 
entire screen. If you use multiple screens, it will take a 
separate screenshot for each display.


Capturing A Selected Portion


https://www.simplymac.com/ipad/how-to-ipad-screenshot
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For more control, press Shift-Command-4. This turns the 
cursor into a crosshair. Click and drag to select the area 
you wish to capture. Upon releasing the mouse or 
trackpad button, the Mac saves the selected portion as 
an image file.


Capturing A Specific Window 


Or Menu

To capture just one window or menu, press Shift-
Command-4 and then tap the Spacebar. The cursor 
changes to a camera icon. Hover over the window or 
menu, and click to take the shot. This function highlights 
the chosen area, ensuring only the selected window or 
menu is captured.


Managing and Editing 
Screenshots

When using a Mac, taking screenshots is a simple task 
but managing them requires knowledge of system 
preferences and editing tools. This section will guide you 
through adjusting settings, editing captures with 
precision, and sharing your screenshots efficiently.




Accessing And Changing 
Screenshot Settings

Mac allows you to configure screenshot settings through 
System Preferences. You can set options like save 
location, choosing between saving to the desktop, 
clipboard, or a designated folder. To change these 
settings, one must go to System Preferences, click on 
Keyboard, choose the Shortcuts tab, and select 
Screenshots. Here, you can assign where screenshots are 
saved and even set a timer for delayed captures.


Editing And Annotating 
Screenshots

After capturing, screenshots open directly in the Preview 
app where detailed edits can be made. Use Markup tools 
to add text boxes, shapes, and draw on your screenshot. 
To further customize, change the font style, size, and 
color. If more advanced tools are needed, third-party apps 
like Monosnap, Skitch, or Snagit offer enhanced features 
for annotation and editing.


File Management And Sharing
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Upon editing, one can save the screenshot as a PNG file 
or convert it to another file format using the Save As 
option. This is important for situations where different 
formats are required for sharing purposes. For quick 
sharing, use the Share button within Preview to send 
screenshots via email, messages, or social media. 
Additionally, consider organizing screenshots in folders 
within Finder to keep your files sorted for easy access.


	  

V.  Deals 

	     A.  Amazon Takes $50 Off  
Apple Watch SE 3, Starting at $199 
Saturday January 3, 2026 9:35 am PST by Mitchel Broussard 
Amazon this weekend has the Apple Watch SE 3 on sale at all-
time low prices, starting at $199.00 for the 40mm GPS model. 
These prices are matching the Black Friday discounts we tracked 
in November, but stock is low, particularly on the 40mm GPS 
model. 

https://www.macrumors.com/2026/01/03/amazon-50-off-apple-watch-se/
https://www.macrumors.com/2026/01/03/amazon-50-off-apple-watch-se/
https://www.macrumors.com/author/mitchel-broussard/
https://buy.geni.us/Proxy.ashx?TSID=3088&GR_URL=https%3A%2F%2Fwww.amazon.com%2Fdp%2FB0FQFLKNSK%3Ftag%3Dmacrumors-20%26linkCode%3Dogi%26th%3D1%26psc%3D1


	     B.  Get this M3 iPad Air 
with 5G for less than Apple 
charges for the Wi-Fi model 
Get a 13-inch screen and 5G for under $800

By Michael Simon 5 days ago


	 C.  Last call for Christmas: 
These $199 AirPods Pro 3 are the 
perfect gift

The newest AirPods Pro are down to $199 and will still arrive in 
time for Xmas.


	 D.  The M4 MacBook Air 
returns to its $749 all-time low

That's a $250 discount for one of the best laptops out there, with 
time to get it before Christmas.
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	 E.  Best iPad Deals: Avoid 
paying full price for a new iPad

UPDATED


Save money on the full range of iPads with our round up of the 
best iPad, mini, Pro and Air deals with buying advice.

By Karen Haslam 10 hours ago


	 F.  Best Apple deals for January 
2026: New year, new savings!

UPDATED


We've used our expert experience with Apple products and 
pricing history knowledge to find the best deals on Apple 
products in the U.S. and U.K.

By Karen Haslam and Michael Simon 15 hours ago 

	 G. 
Check off your New Year’s resolution list 
with $100 off the Apple Watch Series 11 
Get a brand new Apple Watch for as low as $299 in this Amazon 
sale.

By Michael Simon 4 days ago
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	 H.  Amazon Introduces Massive 
Discounts on M5 iPad Pro, Get Up to 
$518 Off Select Models [Updated]

Wednesday January 7, 2026 7:14 am PST by Mitchel Broussard 

Amazon this week is offering discounts across the M5 iPad Pro 
lineup, including both 11-inch and 13-inch models. The highlight 
this time around is the 2TB Wi-Fi 11-inch M5 iPad Pro, which is on 
sale for $1,480.80 with an on-page coupon, a massive discount 
of $518 on the original price of $1,999.00. 

 
Note: MacRumors is an affiliate partner with some of these vendors. When 
you click a link and make a purchase, we may receive a small payment, 
which helps us keep the site running. 

Otherwise, prices start at $899.99 for the 256GB Wi-Fi 11-inch 
M5 iPad Pro at Amazon, down from $999.00. Many of the deals in 
this sale match — or beat — the record low prices we tracked 
during Black Friday. 
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$99 OFF 
11-inch M5 iPad Pro (256GB Wi-Fi) for $899.99 

For the larger models, you can save up to $180 on the 13-inch 
M5 iPad Pro on Amazon this week. If you're shopping for the 2TB 
Nano-Texture Glass Wi-Fi model, Amazon has this tablet for 
$2,219.00, down from $2,399.00, as well as a few other 13-inch 
models between $100 and $170 off. 

11-Inch M5 iPad Pro 
• 256GB Wi-Fi - $899.99 ($99 off) 

• 512GB Wi-Fi - $1,099.00 ($100 off) 

• 1TB Wi-Fi - $1,499.99 ($99 off) 

• 1TB Nano-Texture Glass Wi-Fi - $1,576.00 ($123 off) 

• 2TB Wi-Fi - $1,480.80 ($518 off) 

• 2TB Nano-Texture Glass Wi-Fi - $1,999.00 ($100 off) 

13-Inch M5 iPad Pro 
• 256GB Wi-Fi - $1,199.99 ($99 off) 

• 512GB Wi-Fi - $1,399.99 ($99 off) 

• 1TB Wi-Fi - $1,785.00 ($114 off) 

• 2TB Wi-Fi - $2,092.09 ($206 off) 

• 2TB Nano-Texture Glass Wi-Fi - $2,219.00 ($180 off) 

If you're on the hunt for more discounts, be sure to visit our 
Apple Deals roundup where we recap the best Apple-related 
bargains of the past week. 
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Update: The on-page coupon deal on the 2TB Wi-Fi 11-inch iPad 
Pro has expired. 

	  

VI.  TIPS & TRICKS  

	 A.  21 Time-Saving iPhone Tips 

	 B.   iPhone Mirroring Not Working? 

	 C.  One AirPod Not Working? 

	 D.  14 macOS Tips to Make 
Your Life Easier   
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	 E.  15 New Things Your 
iPhone Can Do in iOS 26.2 

	 F.  Your iPhone Can Ask Why 
Someone's Calling Before You Pick 
Up 

	  G.  Image Playground Guide 

	 	  

	   H.  Use Edge Light for 
Better Video Calls in macOS 
Thursday December 18, 2025 8:36 am PST by Tim Hardwick 
Apple in macOS Tahoe 26.2 introduced Edge Light, a clever new 
feature that turns your Mac's display into a virtual ring light 
during video calls. Instead of fumbling with external lighting 
equipment, your Mac can now illuminate your face automatically 
when you're sitting in a dark room. Basically, Edge Light adds a 
soft glow around the edges of your display to brighten your face 
during video ... 
Read Full Article • 60 comments 
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	 I.  Make Your iPhone 
Display Flash for Alerts 
Wednesday December 17, 2025 3:17 am PST by Tim Hardwick 
Unlike some Android phones, iPhones don't have a dedicated 
notification LED that lights up when you get a call, text, or other 
alert. What iPhones do include is an optional Accessibility feature 
for the deaf and hard of hearing that blinks the rear camera flash 
and provides a visual cue for incoming notifications. And in iOS 
26.2, Apple has added the ability to flash the front display, too.... 
Read Full Article • 29 comments 

	 J.  Do More With Spotlight in 
macOS Tahoe 
Wednesday December 3, 2025 4:21 am PST by Tim Hardwick 
In macOS Tahoe 26, Apple gave Spotlight a major update with a 
visual overhaul, clipboard access, and Actions for performing 
tasks within apps directly from the search bar. There's quite a lot 
of hidden potential in Spotlight's new manifestation. Below, we've 
put together a cheat sheet of Spotlight functionality to help you 
make the most of it. Getting Started With Spotlight You can 
open... 
Read Full Article 

	 K.  iOS 26: See Your Full Call 
History With Any iPhone Contact 
Wednesday October 8, 2025 1:16 am PDT by Tim Hardwick 
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Buried within iOS 26 is a hidden history that lets you see every 
call you've ever exchanged with a specific contact, potentially 
going back years. You might not know it, but you can access this 
detailed call history on your iPhone in seconds. Viewing the new 
extended history screen can come in handy when you need to 
recall when you last spoke with someone. It's also pretty useful 
when you... 
Read Full Article • 60 comments 

	 L.  How to uncover vital 
Mac details with the System 
Information app 

The System Information tool can provide in-depth data 
about the hardware and software on your Mac.



By Lance Whitney

Contributor, Macworld NOV 4, 2021 2:30 AM PDT




Image: Apple


https://www.macrumors.com/how-to/ios-see-full-call-history-iphone-contact/
https://forums.macrumors.com/threads/ios-26-see-your-full-call-history-with-any-iphone-contact.2468688/
https://www.macworld.com/article/353352/how-to-macos-utilities-system-information.html
https://www.macworld.com/article/353352/how-to-macos-utilities-system-information.html
https://www.macworld.com/article/353352/how-to-macos-utilities-system-information.html
https://www.macworld.com/author/lance.whitney


If you’re looking for specific hardware or software 
information about your Mac, maybe to troubleshoot 
a problem, perhaps to upgrade your system, or 
possibly to check on the versions of certain installed 
applications, you can dig up all that data and more 
through the Mac’s System Information utility. Built 
into macOS, System Information provides a wealth 
of details about your hardware, software, and 
network. Here’s how it works.


You can open System Information one of two ways. 
In Finder, click the Go menu, browse to Utilities, and 
in the window that appears, open the System 
Information app. Alternatively, click the Apple menu, 
select About This Mac. At the popup window, 
select System Report.


System Information starts with an overview of your 
hardware. The first screen shows your Mac’s model 
name, processor name and speed, number of 
processors, amount of memory, serial number, and 
other data. In the left column is a list of main 
categories, and you can drill down to see details on 
specific components of that category.







Get information about the components of your Mac in System 
Information.

IDG

Here are a few examples for the Hardware category. 
if you’re having trouble coaxing sound out of your 
Mac, check Audio for info on your audio setup. 
Having issues with Bluetooth? Dive into the 
Bluetooth section. If your battery seems to run out 
of juice too quickly, take a look at Battery. Check 
Memory if you want to upgrade or replace your 
RAM. Go to Storage for details on your hard drive if 
you plan to replace it.




The Network section is useful if you’re bumping into 
connectivity issues. Click the entry for Network for 
an overview of your ethernet and Wi-Fi 
components. The section for Firewall shows the 
current status in case any applications are being 
blocked on your network. Locations displays 
information on the different connections, such as 
ethernet and Wi-Fi. And Wi-Fi shows details on your 
wireless connection.


The Software section displays your macOS version 
and other info. If you need to know the version 
number for an installed program, go to Applications 
and scroll down the list. To see which fonts are 
installed, check out the Fonts category. And to find 
out which apps automatically start up, click the 
Startup items category.







System Information isn’t just about hardware. You can get data 
about the software on your Mac, too.

IDG

You’ll also find a few useful options via the System 
Information menus. To cut down on all the details 
displayed, click the Filemenu and select Show Less 
Information. If you’re working with Apple tech 
support on an issue and need to send them details 
on your Mac, click the File menu and select Send to 
Apple. Finally, if you have to write down the serial 
number for your Mac but can’t see the screen, click 
the File menu and select Speak Serial Number to 
hear it read aloud.




	 M.  As a Mac expert, these 
are the first 9 tweaks I 
recommend for every new 
MacBook 
By Alex Blake

Contributor  
The best things you should do first, from sorting out 
its apps to protecting your privacy. 

	 N.  MAC 911 
By Glenn Fleishman, Contributor, Macworld  
How to block 
annoying, 
reoccuring, 
unwanted website 
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Push notifications 
on your Mac 
You could see scams, spam, and phishing 
without quite knowing why.  (i.e. MacAfee 
Warnings,  subscription renewals, etc .) 

A simple Safari setting solves it. 

Push notifications were the best thing since 
sliced bread when they appeared first in 
Android and later in iOS and iPadOS. Instead of 
requiring a lot of attention, a notification can 
appear briefly, is easily dismissed, and can be 
controlled—you can suppress apps from 
showing them all together, all the way to 
allowing Critical Alerts in some apps for events 
you absolutely don’t want to miss a message 
about.

Apple gingerly added push notifications to 
Safari in macOS to let websites access the 
system-wide notification system because the 

https://www.macworld.com/article/2110589/block-unwanted-website-notifications-mac.html
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increasing reliance on web apps (a website that 
provides an app-like set of features) means you 
could have a tab open performing tasks that 
require your attention.

It’s a double-edged sword, 
though: spammers, scammers, and 
assorted thieves and ne’er-do-wells take 
advantage of any opening to try to part 
you from your money through lies and fear.  

A malicious site can leverage push notifications 
to fill the right edge screen with unwanted 
alerts.

How can this happen? You visit a safe site that, 
through the vagaries of ad networks, is hosting 
an advertisement that either you click on 
without realizing the danger or the bad ad runs 
illegitimate JavaScript to force open a window 
or prompt you to open one. You might also visit 
a URL for a site that has been hijacked or failed 



to renew its domain registration, and now 
you’re on a page of no repute.

However you get there, a malicious site 
incorporates a request in the page you load that 
triggers Safari to prompt you to ask if you want to 
enable notifications for the site or not. This is harder 
to trigger in iOS and iPadOS, which only allow 
notifications from web pages you’ve added to your 
home screen.


Misleading messages on 
macOS Safari

When Apple first introduced the feature to macOS, it 
only allowed developers to trigger a standard dialog 
box that said Don’t Allow and Allow, with Allow 
highlighted. Not long after, Safari began to allow a 
custom opt-in message and design. The text that 
appears can be entirely misleading: it’s possible that 
you would click a button intending to not allow 
alerts and actually have opted in to them. For 
instance, the text that misled one Macworld 
reader says: 

[space]ask you 
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Confirm that you’re not a robot, you need click 
Allow 



I must have been taken in once because I found this 
entry in Apple menu > System Settings > 
Notifications on my Mac.


As long as the web page remains open, even if it’s 
in a window or tab you’re not viewing, it can send 
you notifications. Because Apple shows the 
favicon of the website (a small icon set by the 
site owner), as part of the notification, it can be 
quite misleading.  

For example, in the figure below, the favicon is a 
System Preferences icon with a red dot overlaid. 


A reader sent these screens of malicious notifications 
from the “Ask You” site.


That gives the impression it’s a macOS notification 
but it’s not. 

 
Clicking the notification takes you to the web 
page trying to sucker you, and then the site tries 
to lure you into installing malware, typing in your 
credit-card number, or much worse. 



All that said, you can easily defeat the creeps 
who set you up by disabling notifications. (And 
find and close that tab or window!) 

In macOS: 

1. In Safari, go to Safari > 

2. Settings/Preferences >

3.  Websites.


4. Find the entry for the website. If you can’t find it 
by domain, look for the icon, as in the figure 
below.


5. Choose Deny from the popup menu to the right 
of the site name or select the item and click 
Remove.







Use Safari’s Websites pane with Notifications selected at left 
to block sites from popping up alerts. 
Foundry


How do you decide whether to choose Deny or click 
Remove?




• Choosing Deny means if you visit the site again, 
an alert about wanting to notify you won’t 
appear.


• Removing the entry means it doesn’t appear in 
the Notification settings/pane in System 
Settings/Preferences or in Safari’s Websites list.


You can also use Apple menu > 


System Settings > 


Notifications 


to disable notifications directly. 


Safari and the Notifications settings don’t seem to 
communicate directly: 


I had the malicious site described 
above set to Deny in Safari, yet in 
Notifications it was shown as 
enabled!







The System Settings/Preferences Notifications controls don’t 
seem to match Safari’s. 
Foundry


In iOS/iPadOS:


1. Go to Settings > Notifications

2. Find the entry for the home page web app by 

title, and disable notifications for it.

3. Also, you might want to remove that from your 

home screen altogether–that site is sending you 
unwanted notifications!




EXPLORE FREQUENTLY ASKED QUESTIONS

• How do I disable notifications for all websites on 

Safari? 

• How do I manage website notifications on my 
iPhone or iPad? 

• Can I use Safari's private browsing mode to avoid 
website notifications? 

• How do I disable notifications for a specific 
website on iOS? 

• How do push notifications work on Mac? 

A.I. Search 

	 N. Apple secretly 
boosted Wi-Fi 
speeds on your Mac 
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and iPad–here's 
how to get it 
The latest free software updates has a hidden feature that bumps 
bandwidth.

By David Price 11 hours ago


	 O.  iOS 26: Switch Back 
to the Classic Phone App 
Layout


Tuesday November 4, 2025 3:50 AM PST by Tim Hardwick 

Apple's redesigned Phone app in iOS 26 introduces a unified 
view that combines recents, favorite contacts, and search on 
a single screen. But if you prefer the familiar tabbed interface 
from iOS 18, you can easily switch back to the classic layout. 
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The Classic Phone app layout in iOS 26 

What's Different in iOS 26 
The new unified design consolidates recent phone activity 
into one streamlined view in which your favorite contacts 
appear at the top for quick access. You can navigate to 
Contacts, Keypad, and Search through the bottom tab bar, 
while screens for voicemail and missed calls can be accessed 
via the three-line icon in the top-right corner. 

Switching Back to the Classic 
View 
If you don't get on with the new look in iOS 26, here's how to 
revert to the traditional Phone app layout: 



1. Open the Phone app on your iPhone. 

2. Tap the three-line icon in the upper right corner of the 
screen. 

3. Select Classic from the popup menu that appears. 

 



Your Phone app will immediately switch to the original iOS 18 
design, with separate tabs for Recents, Contacts, Keypad, 
and Voicemail along the bottom. 

Switching Back to the Unified 
View 
Changed your mind? You can return to the new unified layout 
at any time in the following way: 

1. Tap the three-line icon in the upper right corner of the 
Phone app. 

2. Select Unified from the popup menu. 

The unified view becomes your new default until you switch 
back again. Your preference persists across app launches, so 
you won't need to change it every time you open the Phone 
app. 

	 P.  iOS 26.1: 
Reduce Liquid 
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Glass Effects With 
Apple's New Toggle 
Tuesday November 4, 2025 3:49 AM PST by Tim Hardwick 
With iOS 26, Apple introduced a radically new design material 
called Liquid Glass which focuses on transparency in order to 
let the content on your display shine through the controls. 
Not everyone likes it though – so Apple has responded by 
adding a new toggle in iOS 26.1 that lets you tone down the 
effects. 

 
 
Any major design change can create controversy as people 
get used to the new look, but Apple's debut of Liquid Glass in 
iOS 26 proved particularly divisive, with its buttons and 
menus that change color and refract digital light like they're 
physical objects. Some people appreciate the translucent 
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effects, while others find them distracting or harmful to 
readability. 

Fortunately, Apple has listened, and in its first iOS 26.1 point 
update now available, the company has introduced a new 
toggle that should hopefully ease some of the criticism. Apple 
says that the new setting was added after user feedback 
during the beta testing period suggested that some people 
would prefer to have a more opaque option for Liquid Glass. 

The toggle lets you select from a clear look for Liquid Glass, 
or a tinted look. Clear is the current Liquid Glass design, 
which is more transparent and shows the background 
underneath buttons, bars, and menus, whereas tinted 
increases the opacity of Liquid Glass and adds more contrast. 

Tone Down Liquid Glass in iOS 
26.1 
If you're not a fan of the look, or are having trouble with 
readability, then make sure that you update to iOS 26.1 
when it's released (likely early November) and then follow 
these steps. 

1. Open the Settings app on your iPhone or iPad. 

2. Tap Display & Brightness. 

3. Tap Liquid Glass. 

4. Tap Tinted to increase opacity and add contrast, or 
Clear for more transparency. 



 
That's all you need to do – the change is applied 
immediately. If you're on macOS Tahoe 26.1, you can 
find the same setting available on your Mac in System 
Settings ➝ Appearance. 

VII. Miscellaneous 



  
	 A.  CES 2026: Birdfy Debuts 
Hummingbird and 360-Degree Vista 
Feeders 
Friday January 2, 2026 11:21 am PST by Juli Clover 
Birdfy today debuted two new products, the Birdfy Feeder Vista 
and the Birdfy Hum Bloom, which join the company's line of 
camera-equipped accessories designed for bird watching. 

 
 
The Birdfy Feeder Vista is a 360-degree smart bird feeder that 
features two cameras able to capture 14-megapixel panoramic 
images and record 6K HD video. The Vista is a pole-based camera 
option that offers a bottom-up feeding system. There's an air 
pump that feeds seed into a sealed lower container to the feeding 
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tray, so there is no seed hopper that blocks the view of the 
camera. 

	 B.  Track a Flight on 
Your iPhone 

Tuesday December 23, 2025 2:27 am PST by Tim Hardwick 
Flight tracker apps are a popular way to keep tabs on planes in 
the sky, because when you're preparing to fly or when someone 
you know is on board a flight, you can use them to check that 
things are still on schedule. But if you have an iPhone, you don't 
need to download and install a third-party app to track a flight – 
it's a handy built-in feature of the operating system. The ability to 
... 
Read Full Article • 24 comments
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